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1.About FishStatJ

FishStatJ is a desktop application designed to disseminate FAO fishery statistical
data to the world. FishStatJ’s primary aim is to display, refine and export data.
However, unlike a spreadsheet software it cannot modify the data, create graphs or
perform advanced data analysis. One of FishStatJ’s greatest strength is that it can
display species according to several authoritative classifications, such as the
International Standard Statistical Classification of Aquatic Animals and Plants
(ISSCAAP) or the UN’s Central Product Classification (CPC); and show the scientific
name.

At the 23rd CWP meeting (2010), the prototype of FishStatJ was endorsed for full
development and the first release of FishStatJ was delivered in 2011. FishStatJ is
built using the Eclipse Rich Client Platform (Eclipse-RCP) tools. As such, it is a Java
application, and requires that Java is installed on the computer. RCP allows to
develop general purpose applications, which run on Windows and macOS.

FishStatJ build and improves on the features of FishStatPlus (its predecessor):
* all Fishery reference data is available (all FAO code lists with all attributes);
* all hierarchies are available (for view, and for filtering/aggregation);
* calculated columns of FishStatPlus are included;
* the software is cross-platform (Windows, Macintosh) ;
* data (workspaces) of dimensions can be defined as needed (flexible); and
* any data with fixed dimensions and yearly resolution can be loaded.

For the creation of workspace files (database files), a separate software called
“FishStatd Console” was developed.

In order to use the statistical data, the user has to download and install the
FishStatJ application on his computer (more details follow).



2.Installation
2.1.Installing on Windows

To download FishStatJ for Windows, go to fao.org/fishery/statistics/software/fishstatj/
en.

FishStat] - Software for Fishery and Aquaculture
. Statistical Time Series

FishStat] is a Windows and Mac application that anyone can use to
access FAQO'’s Fisheries and Aquaculture statistics. They include datasets
on production, trade and consumption. Data can be extracted and
aggregated according to different level of details and international
standard classifications. It consists of a main application and several
workspaces that include the datasets.

List of data available within FishStat] 4+]
FishStat] key features

e datasets browsing, data mining and reporting
e data querying, filtering, grouping and aggregation . Related topics

Installing FishStat] v4.01.0 Statistics - Introduction

Download FishStat]
o for Windows64-bit (7,8,10) auto-extract (Instructions)
o for macOS

2.1.1.Windows requirements

FishStatJ is compatible with Windows 10; 64-bit version; cannot work with Windows
32-bit. The troubleshooting section below describes how to check your version of
Windows.

Starting with FishStatJ version 4.01 Java 11 (OpenJdDK project) is included with
FishStatJ.

The FishStatJ needs about 1.5GB of disk space (400MB for the application, and the
rest for data).

FishStatJ requires between 1Gb and 4GB of memory, depending on the size of the
dataset used.

2.1.2.32bit Windows installer

Starting with version 4.01.0 (as of March 2021) 32-bit Windows Operating system is
not supported any more.


http://www.fao.org/fishery/statistics/software/fishstatj/en
http://www.fao.org/fishery/statistics/software/fishstatj/en

2.1.3.Using Windows auto-extract installer

When running the auto-extract installer (FishStatJ_Installer.exe), it will ask for the
following permission:

g FishStat) auto-extract

g@) Install to C:\FishStat] ?

Yes No |

After clicking on the Yes button, the installer will extract the application to C:
\FishStatJ, and immediately launch FishStatJ after the extraction is complete.

@0 -
“ Home Share View 9
<« v M > ThisPC » OSDisk (C:) » FishStat) v D Search FishStat) el

~
[ This PC ) Name Type Date modified Size

J 3D Objects configuration File folder 19-Mar-19 16:18
Desktop plugins File folder 19-Mar-19 10:42
= % FishStat).exe Application 18-Mar-19 11:50 307 KB
=] Documents X

7| FishStat.ini Configuration sett... 18-Mar-19 11:50 1 KB
* Downloads X . ) . . e n I

"L Installing on Windows 3.04.pdf Adobe Acrobat D...  18-Mar-19 11:50 339KB
D Music '] workbench.xmi XMI File 19-Mar-19 16:48 108 KB
&=/ Pictures
B Videos
‘am OSDisk (C:)

v
6 items =

No further action is required.

Note: The FishStatJ_Installer.exe file is not a real installer but a 7-Zip auto extract
archive. As such, it does not require administrative permissions. | requires
permissions to create the FishStatJ folder on the C:\ disk; this permission is usually
available using accounts that lack Administrative rights.

2.1.4.Do not move or rename files

Please do not move or rename the files and folders, this will break the program. To
resolve a corruption issue, delete the entire folder and it's content: C:\FishStatJ and
run the Install.exe program again to extract the whole folder structure.



2.1.5.Adding FishStatJ to the Taskbar

Applications can be added to the Taskbar (usually on the bottom of the screen) by
right-clicking on the FishStatJ.exe file and select the Pin to Taskbar option.

,

Name Date modified
configuration 4/5/2018 9:20 AM
. plugins 4/4/2018 4:18 PM
“% FishStat! =~ 44018 11:39 AM
5 FishStaf | OPem 11:39 AM

( Pin to Taskbar } [}

Pin to Start Menu

Restore previous versions

A FishStatJ shortcut has now been added to the Taskbar:

M o3 9




2.2.Windows troubleshooting

2.2.1.Installation issues

FishStatJ is a 64-bit software, and therefore requires Windows 10, 64-bit. In the case
the FishStatJ application does not start (show the FishStatJ logo, then the main
menu); perform the following steps to delete and re-copy the application:

* Before launching the EXE Auto-Extract to install a new version, exit any open
instance of FishStatJ (File — Exit) so that the files of the new version can be
copied.

* Delete the FishStatJ folder inside the C:\ disk. using Windows explorer.

* Re-run the FishStatJ auto-extract EXE

2.2.2.How to check if your computer supports 64-bit

FishStatJ is a 64-bit software, and therefore requires 64-bit Windows. The reason for
this 64-bit requirement relates to the memory handling required for loading statistical
data.

To check if your computer is running Windows 64-bit, please refer to the following
Microsoft Support webpage: support.microsoft.com/en-us/help/13443/windows-
which-operating-system

% Home About
Find a setting Device specifications
Device name PC009254
System Processor ntel(R) Core(TM) i5-4590 CPU @ 3.30GHz
- 3.30 GHz
L3 Display
Installed RAM 8.00 GB
[] Notifications & actions Device ID
Product ID
" Power & sleep System type 64-bit operating systemx64-based
processor
= Storage Pen and touch No pen or touch inp % available for this

display

C® Tablet mode

System type shows whether your computer is running a 32- or 64-bit version of
Windows.


https://support.microsoft.com/en-us/help/13443/windows-which-operating-system
https://support.microsoft.com/en-us/help/13443/windows-which-operating-system

2.2.3.Diagnostic reporting

In case you encounter an issue with the application, please turn on Log diagnostic
reporting, which you can find in the Edit — Preferences menu and then exit and re-
launch FishStatJ.

When you turn on Log diagnostic reporting in the Preferences, FishStatJ will
check and create a log report if the program encountered an error. Please do share
this report with us — it helps us to diagnose problems.

#4 Preferences O X

I General preferences v v v

General preferences .
P Fishstat) general preferences

Data display

Data export Save/Load timeseries settings on exit/open
Internet access Synchronize timeseries within the same dataset
Languages

Log diagnostic reporting

Workspace download location

C:\Users\Esspiope\Downloads

Restore Defaults Apply

Apply and Close Cancel

We are working constantly to update our data; publishing workspaces with the latest
fisheries and aquaculture data. We are grateful for any type of feedback, since it
allows us to improve the application.

2.2.4 How to check that FishStatJ is not corrupted

We have included a text file (TXT format), on the web-page which provides the hash
for the FishStatJ_Installer.exe (auto-extract). Once extracted, you find a TXT file with
the FishStatJ.exe hash in the C:\FishStatJ folder.

The hash is calculated using the CERTUTIL tool, which is standard on Windows 10.

To check, open a DOS window, then change to the directory using the CD command.
Then run CERTUTIL --hashfile FishStatJ.exe

or CERTUTIL --hashfile FishStatJ_Installer.exe.

This will provide the hash calculated from the EXE file, which you compare against
the hash we provide.

This way you can be sure, that the EXE files have not been tampered with.



2.3.Installing on macOS

To download the FishStatJ for macOS, please go to fao.org/fishery/statistics/
software/fishstatj/en.

FishStat] - Software for Fishery and Aquaculture
. Statistical Time Series

FishStat] is a Windows and Mac application that anyone can use to
access FAO'’s Fisheries and Aquaculture statistics. They include datasets
on production, trade and consumption. Data can be extracted and
aggregated according to different level of details and international
standard classifications. It consists of a main application and several
workspaces that include the datasets.

List of data available within FishStat] 4+]1
FishStat] key features

e datasets browsing, data mining and reporting
e data querying, filtering, grouping and aggregation \ Related topics

Installing FishStat] v4.01.0 Statistics - Introduction

Download FishStat]
o for Windows64-bit (7,8,10) auto-extract (Instructions)
o for macOS

2.3.1.macOS requirements
FishStatd is compatible with macOS 10.13 (HighSierra) or later.

Starting with FishStatJ version 4.01 Java 11 (OpenJDK project) is included with
FishStatJ.

The FishStatJ needs about 1.5GB of disk space (500MB for the application, and the
rest for data).

FishStatJ requires between 1Gb and 4GB of memory, depending on the size of the
dataset used.

2.3.2.Installation

After the FishStatJ application is extracted from the ZIP file, it can be launched
directly run from the Desktop, or moved to the Applications folder.

The FishStatJ application is code-signed and starting with version 4.01 is also
notarized with Apple. As it is not an application from the app store: at the first launch
it requires the actions below in order to obtain permission to run.


http://www.fao.org/fishery/statistics/software/fishstatj/en
http://www.fao.org/fishery/statistics/software/fishstatj/en

2.3.3.Authorization

In order to authorize FishStatJ ,security settings need to be adjusted in System
Preferences — Security & Privacy; to change settings the Preferences Panel must
be unlocked first.

@ < £2is Security & Privacy Q

.ﬁgﬁ. FileVault  Firewall  Privacy

A login password has been set for this user = Change Password...

Require password immediately u after sleep or screen saver begins
Show a message when the screen is locked

Disable automatic login

Allow apps downloaded from:

Mac App Store
<O Mac App Store and identified developers >
 Anywhere

~
Click the lock to prevent further changes. Advanced... ?

For details on macOS security refer to https://support.apple.com/en-us/HT202491.
The next step is to download workspaces, for this please refer to section 3.1.1.



https://support.apple.com/en-us/HT202491

2.4.macOS troubleshooting

2.4.1.Diagnostic reporting

In case you encounter an issue with the application, please turn on Log diagnostic
reporting, which you can find in the Edit — Preferences menu and then exit and re-

launch FishStatJ.

When you turn on Log diagnostic reporting in the Preferences, FishStatJ will

check and create a log report if the program encountered an error. Please do share

this report with us — it helps us to diagnose problems.

#4 Preferences O
typ ext General preferences ~ ~
General preferences :
. E Fishstat) general preferences
Data display
Data export Save/Load timeseries settings on exit/open
Internet Access Synchronize timeseries within the same dataset
Languages
s Log diagnostic reporting
Workspace download location
C:\Users\* \Downloads
Restore Defaults Apply
Apply and Close Cancel
1

We are working constantly to update our data; publishing workspaces with the latest

fisheries and aquaculture data. We are grateful for any type of feedback, since it
allows us to improve the application.




2.5.FishStatJ Privacy Policy

FishStatJ does not process or store any user input, and does not collect any user
related information.

FishStatJ downloads a small file at startup, this requires an internet connection:
- in order to inform the user about program updates

- in order to present the user with a list of workspaces available for download
This is described in detail in section 12.6 (update notification).

The internet connection is used to download workspaces (statistical data), as
described in section 3.1 (manage workspaces). The download of workspaces is
entirely under the control of the user. The download location can be customized in
general preferences 5.4.1.

The location of the data is described in detail in section 12.4 (workspace folder).

The workspace folder contains the application log. The log contains information
about the internal state of the program - no user information. The log can be viewed
by the user as described in section 2.2.4 (diagnostic reporting); section 12.4
(metadata folder).

FishStatJ does save program settings modified by the user. The settings are
managed using preferences as described in section 5.4 (Preferences).

Eclipse RCP (Rich Client Platform) is Java based, and as such FishStatJ requires
OS permissions to run the Java and Eclipse IDE code. The open-source OpenJDK
Java is included with FishStat.

FishStatJ is designed to run using normal user permissions on Windows and
macOS; elevated permissions are not required.

10



2.6.Workspaces (statistical data)

Workspace files carry the statistical data. You can install an unlimited number of
workspaces on a computer. However, FishStatJ can only work with one workspace

at a time.

A workspace can contain one or more datasets. For the dissemination of data,
workspaces are compressed into workspace files (.wks extension). FishStatJ
downloads and extracts/installs workspaces automatically.

We currently offers several different workspaces files, which contain the following

datasets:

* the Global Production workspace which contains:

O

(@)

Global Production
Capture Production

o Aquaculture Production

* the Regional workspace with contains:

O

O

O

(@)

CECAF (Eastern Central Atlantic)

GFCM (Mediterranean and Black Sea)
RECOFI capture production

SEATL Southeast Atlantic Capture Production

* the Food Balance workspace which contains:

O

O

Food Balance Sheet
Population data

* the Commodities workspace which contains:

O

Fisheries Commodities Production and Trade

Please refer to section 3.1 (manage workspaces) for loading data into FishStatJ.

11



3.File Menu

3.1.Manage workspaces

The Manage workspaces menu allows the user to manage the workspaces:
* Open workspaces already installed.
* Download and install workspaces (from the FAO website).
* Delete workspaces installed on the computer.

¥4 Fishstat)
File Edit Data Format View Metadata Help
Open dataset... Ctrl+0 W
Open workspace... >
Manage workspaces Ctrl+W
%"_lr--; unrlecnara
l To start: download and install new workspace
Export selection (CSV file)... Ctrl+S
Exit

When you click on Manage workspaces, the Workspaces Manager window
appears on the screen. There, two kind of workspaces are displayed:

* Workspaces in [[SBIBBIBI, are not installed on the computer (also if there is a
new version available).

* Workspaces in blue color are installed on the computer.

The screenshot below shows that version 2018.1.0 of the “FAO Global Fishery and
Aquaculture Commodities Statistics” workspace is installed on the computer:

12



#4 Workspaces Manager

Manage FishStat) workspaces:

Download, Import, Delete and Open workspaces|

Name

FAO Food balance sheets of fish and fishery products
FAO Global Fishery and Aquaculture Production Statistics

[FAO Global Fishery and Aquaculture Commodities Statistics I
FAQ Regional capture fisheries statistics

Download...

Import...

Acronym FAQO_FI_GLOBAL_TRADE
Name FAO Global Fishery and Aquaculture Commodities Statistics
Description FAQ Global Fishery and Aquaculture Commoedities Statistics
Provider Food and Agriculture Organization of the United Nations
Location|C:\Users\I" & \fishstatj_workspace\ws_0002 |

Close

Workspaces already installed on the local disk can be Opened for viewing the data,
or Deleted from the computer.

Manually downloaded workspaces can be imported using the Import button.
Workspaces that are already installed are not shown as available for download.

13




3.1.1.Installing a new workspace (download)

To install a new workspace, select an uninstalled (in red) workspace and click on the

Download... button.

Acronym FAQ_FI_FBS [ Version 2017.1.0 |
Name FAO Food balance sheets of fish and fishery products
Description Internet: autematic download
Provider http://www.fao.org/fishery/static/FishStat)
Location /FAO_FI_FBS_2017.1.0.fws

#4 Workspaces Manager O X
Manage FishStat) workspaces:

Download, Import, Delete and Open workspaces

Name Open...
| FAO Food balance sheets of fish and fishery products | Delet

FAO Global Fishery and Aquaculture Production Statistics S

FAO Gleobal Fishery and Aquaculture Commodities Statistics (( Download... [)

FAQ Regional capture fisheries statistics '

Import...

Close

14



Clicking on the Download button will open a new window, the workspace import

wizard:

=
FishStat) workspace download
(0 The download is complete|

O X

L

Download from:

http://www.fao.org/fishery/static/FishStat)/FAO_FI_FBS_2017.1.0.fws

Download to:

C:\Users\Iismse w\Downloads\FAO_FI_FBS_2017.1.0.fws

ik o> D e

Cancel

A progress bar appears during the download:

Downloading workspace

15



Once the file has finished downloading, press the Next button to install it on your
computer.

FishStat) new workspace import

(1) The selected file is a valid workspace file. Press "next" to install it on your computer.

O X

File selected IC:\Users\l'!.’l p\Downloads\FAO_FI_FBS_2017.1.0.fws

Workspace metadata

Acronym FAO_FI_FBS Version 2017.1.0
Name FAO Food balance sheets of fish and fishery products

Description FAO Food balance sheets of fish and fishery products

Provider Food and Agriculture Organization of the United Nations
Location C:\Users\Fsmusm\Downloads

< Back ' Next > 'p

Finish

16



If an older version of the data is present (this typically happens after the yearly
release of updated workspaces from FAQO), FishStatJ will ask if the new version
should overwrite the old version — or keep both (resulting in two versions of the same
data installed). Select the option most appropriate for you, and click Next.

=

e

FishStat) new workspace import

Workspace metadata
Acronym  FAO_FI_REGIONAL Version 2016.1.0
Name FAQ Regional capture fisheries statistics

Description FAO Regional capture fisheries statistics

Provider Food and Agriculture Organization of the United Nations
Location  C:\Users\berger\Desktop

Warning!

This workspace is a different version of an already installed one. You can choose to overwrite the
previous workspace with this one (recommended), or keep both of them.

() Overwrite
@ Keep both

< Back _ Next > 4 Finish

o e

3‘.& e

Check workspace : : ?

File selected  C:\Users\berger\Desktop\FAO_FI_Regionals_2016.1.0.fws

-

Please wait while the workspace is installing.

Workspace installation

17



When the installation is complete, click the Finish button.

=

FishStat) workspace import

(i) The workspace installation is complete

Workspace metadata
Acronym FAO_FI_FBS Version 2017.1.0
Name FAO Food balance sheets of fish and fishery products
Description FAO Food balance sheets of fish and fishery products
Provider Food and Agriculture Organization of the United Nations

Location C:\Users\* ™. ® "\Downloads

A
oo
[N
[al
o=
lg
v
-
%

After clicking on Finish, the Dataset browser window appears. To start using your
newly installed workspace, please refer to section 3.2 (open dataset) below.
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3.1.2.Deleting a workspace

#4 Workspaces Manager O X

Manage FishStat) workspaces:

Download, Import, Delete and Open workspaces

Name Open...
i FAO Food balance sheets of fish and fishery products :
FAQ Global Fishery and Aquaculture Production Statistics Y —— —
FAO Global Fishery and Aquaculture Commodities Statistics Download...
FAQ Regional capture fisheries statistics

5 Delete...

Import...

Acronym FAO_FI_GLOBAL_PROD [version 2018.1.0 |
IName FAO Global Fishery and Aquaculture Production Statistics I
Description FAO Global Fishery and Aquaculture Production Statistics
Provider Food and Agriculture Organization of the United Nations

Location C:\Users\|Wmmm\fishstatj_workspace\ws_0001

Close

In the Workspaces manager, selecting a workspace will show metadata for this
particular workspace (Acronym, Version, Name, Description, Provider, and Location
on disk). The selected workspace is permanently removed from your computer when
you click on the Delete button.

3.1.3.Importing a workspace

The Import... button allows the user to import manually downloaded workspaces
into FishStatJ. However, since FishStatJ is able to download workspaces files, most
users do not need to download and import workspaces manually.
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If you need to import a workspace manually, click on the Import... button of the
Workspaces Manager.

#4 Workspaces Manager O X

Manage FishStat) workspaces:

Download, Import, Delete and Open workspaces

Name Open...
FAO Global Fishery and Aquaculture Production Statistics Delete...
FAO Food balance sheets of fish and fishery products
FAO Gleobal Fishery and Aquaculture Commodities Statistics Download...
FAQ Regional capture fisheries statistics
Import...
Close

A file explorer window will appear, inviting you to select the .fws file corresponding to
the workspace you wish to import. Select the .fws file and click on the Open button.

¥4 Workspace file selection X
<« v P ‘ > ThisPC » Downloads v O Search Downloads P
Organize v New folder =~ @ @
& OneDrive - Food ¢ = Name Date - Type Size
[ This PC Scripts-20190319T084456Z-001 19-Mar-19 09:48 F?Ie folder
o OMAN 12-Mar-19 10:56 File folder
- 3D Objects VM _outputs_massawa_2018-05-28 11-Feb-19 18:00 File folder
I Desktop VM_outputs_massawa_2019-01-23 11-Feb-19 13:22 File folder
5| Documents FishStatL 20412 wi 30-Jan-19 13:58 File folder
Jy Downloads IéAO_FI_GIobaI_Production_2018.1.0.fws 9-Mar-19 11:20 FWS File 9,46(
D Music
[&=] Pictures
B Videos
‘i OSDisk (Cy) v < >

File name: | FAO_FI_Global_Production_2018.1.0.fws v| | dws v
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In the window that appears, click on the Next > button.

=] O X
FishStat) workspace import
(i) Aworkspace file is selected
select file
C:\Users\Ilsmtiew\Downloads\FAO_FI_Global_Production_2018.1.0.fws
<gack [ Net> 1 Ensh | Cancel

The following window is displayed, confirming that you have selected a valid
workspace file and inviting you to install it on your computer. To do so, click on the

Next > button.

FishStat) new workspace import
(1) The selected file is a valid workspace file. Press "next" to install it on your computer.

File selected |C:\Users\|'!l£.li\DownIoads\FAO_FI_GIobaI_Production_2018.1 0.fws

Workspace metadata
Acronym FAO_FI_GLOBAL_PROD Version 2018.1.0
Name FAO Global Fishery and Aquaculture Production Statistics
Description FAO Global Fishery and Aquaculture Production Statistics
Provider Food and Agriculture Organization of the United Nations
Location C:\Users\lummwas\Downloads

< Back Net> | Finish [ Cancel
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Once FishStatJ confirms that the workspace installation is complete, click on the
Finish button to go back to the interface and open the workspace.

=

FishStat) workspace import
(1) The workspace installation is complete

Workspace metadata

Acronym FAO_FI_GLOBAL_PROD

Name FAO Global Fishery and Aquaculture Production Statistics
Description FAO Global Fishery and Aquaculture Production Statistics

Provider Food and Agriculture Organization of the United Nations

Location C:\Users\lfuméiu\Downloads

Version 2018.1.0

< Back Next >

Finish

Cancel
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3.2.0pen Dataset...

Note: This option is only available when a workspace is currently open in FishStatJ.

#4 Fishstat) - FAO Global Fishery and Aquaculture Production Statistics
File Edit Data Format View Metadata Help

h Open dataset... cio L &

l Select datasets inside a workspace, first load a current workspace i

Close workspace
Export selection (CSV file)... Ctrl+S

Exit

Selecting this option will present the Dataset browser window, where datasets may
be opened and brought into FishStatJ for viewing.

Once you have opened a dataset, the Manage workspaces item under the File

menu is disabled (or dimmed); until you close the active workspace by clicking on
the Close workspace item.

| Datatset browser

Select a time series or a complete dataset

Dataset Metadata | Dimensions | Attachments | time series

v Global capture production Name Global aquaculture production
Quantity (1950 - 2016)

Acronym  AQUACULTURE Date 2018-03-16
Vv Global aquaculture production Data source FAQ
Quantity (1950 - 2016)

URL http: //www.fao.org/fishery/statistics/global-aquacultur
Value (1 98_4 -2016) ) Description This database contains aquaculture production
Vv Global production by production source statistics by country or territory, species item, FAQ
Quantity (1950 - 2016)

Major Fishing Area and culture environment.

Selecting a dataset by clicking on the items listed on the left-side of the window will
present the associated metadata on the right-side of the window. Select a dataset
and click on the OK button to open the dataset content.
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3.2.1.New data is available

© New data is available for download

You are about to open:
FAO Global Fishery and Aquaculture Production Statistics version 2020.1.0

*—=

Available for download:
FAO Global Fishery and Aquaculture Production Statistics version 2021.1.2

Do you want to download the new version?

Open 2020.1.0  (ENEVACIEIINN

In case there is a newer version of workspace available published for download the
program will ask if you want to open the currently installed (2020.1.0 in this example)
or download the new version.

Clicking on “New Version” will open the manage Workspace dialog - which shows
the new versions available for download in red color.

Note: This function is not available when working off-line; as it requires an active
internet connection.
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3.3.Close workspace

#4 Fishstat) - FAO Global Fishery and Aquaculture Production Statistics
File Edit Data Format View Metadata Help

Open dataset... Ctrl+O 5o %

Manage workspaces Ctrl+W

h Close workspace aculture area (...
- Inland waters  Freshwater

Environment (Envi...

Export selection (q Close the current workspace; in order to open another one i

Exit pe - Inland w...  Freshwater
Albania Lommon carp turope - Inland w...  Freshwater
Albania Crucian carp Europe - Inland w...  Freshwater

Selecting this item will close the current workspace and all datasets and that are

active within this workspace.

Note: The Close workspace option saves settings for all active datasets. Next time

you launch FishStatJ, saved settings are applied. If you do not want a dataset to
open automatically next time you open FishStatJ, just close it using the Close icon

on the dataset panel:

#4 Fishstat) - FAO Global Fishery and Aquaculture Production Statistics
File Edit Data Format View Metadata Help

@ v & ABMG =B L

Country (Country) Species (ASFIS spe... Aquaculture area (... Enviro

Afghanistan Cyprinids nei Asia - Inland waters  Freshw

Note: Filtering and aggregation settings are also recorded for each dataset; and

automatically re-applied when you launch FishStatJ next time.

If the Save working session on exit option (located in Edit — Preferences) is

active, when FishStatJ restarts the datasets that were open when the user exited the

application will automatically reopen.
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3.4.Export selection (CSV file)...

Selecting this option will save all selected rows into a comma-separated values

(CSV) file:
#4 Fishstat) - FAO Global Fishery and Aquaculture Production Statistics

File Edit Data Format View Metadata Help

Open dataset... Ctrl+0  san

Manage workspaces Ctrl+W 016) 22

Close workspace aculture area (... Environment (Envi...

. - Inland waters  Freshwater

I} 23S S LSS AL 2t S Inland waters  Freshwater

Exit Save the current selection to a CSV file Freshwater
Albania Lo Freshwater
Albania Crucian carp Europe - Inland w...  Freshwater
Albania European seabass Mediterranean an...  Marine
Albania Freshwater fishes ...  Europe - Inland w...  Freshwater
Albania Gilthead seabream  Mediterranean an...  Marine
Albania Grass carp(=White... Europe-Inland w...  Freshwater
Albania Kuruma prawn Mediterranean an...  Marine
Albania Mediterranean m...  Mediterranean an...  Marine

A Save As pop-up window will appear so that all
a .csv file on a given location of the hard drive.

=

—

v

M > ThisPC > Documents » FAQ data

Organize v New folder

(~ Name

¢@& OneDrive

[ This PC No items

) 3D Objects
[l Desktop
/2| Documents
4 Downloads
ﬁ Music

| Pictures

B Videos

v

selected rows may be saved into

[J) Search FAQ data

v

Date modified Type

match your search.

File name:

*

Save as type: | *.csv

A Hide Folders

Save Cancel

When the save of the selected records into a .csv file is complete, a confirmation

message will appear:
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"u?'j

"o.' 9 rows have been saved
[ )

Settings for export of CSV files are managed in Edit — Preferences — Data
Export. See section 5.4(data export) for more information.

Note: The CSV file shows the period (years) in brackets, for example “[2022]". This
is a statistical standard also used by FAOSTAT. The reason is to prevent Excel from
recognizing the period as a number which can be aggregated.

3.5.Exit

#4 Fishstat) - FAO Global Fishery and Aquaculture Production Statistics

File Edit Data Format View Metadata Help
Open dataset... Ctrl+O  san %
) 2
Manage workspaces Ctrl+W 016} o5
Close workspace aculture area (... Environn
- et e s - Inland waters  Freshwa
PSSRl s i - Inland waters  Freshwa
Exit pe - Inland w...  Freshwa
Albania Lommon carp turope - Inland w...  Freshwa

Selecting this option will close the FishStatJ program.
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4.Data display

4.1.Displaying a dataset

When a dataset is open, the main window of FishStatJ looks like this:

¥4 Fishstat) - FAO Global Fishery and Aquaculture Production Statistics [} m] X
File Edit Data Metadata View Format Help

@ Y%A BME =B &R

{1, Global capture production - Quantity (1950 - 2016) &2 ‘ E2=08
Country (Country)  Species (ASFIS spe.. * 2008 2009 2010 201 2012 2013 2014 2015 N
Afghanistan Freshwater fishes ... 1000 F 1000 F 1000 F 1000 F 1000 F 1000 F 1000 F 1000 F
Albania Angelsharks, sand... 23 14 78 12 5 5 4 4
Albania Atlantic bluefin tu... - 50 - 0 - 9 34 40
Albania Atlantic bonito 27 21 23 12 5 4 3 27
Albania Barracudas nei 7
Albania Bighead carp 24 5 23 12 13 10 16
Albania Bleak 190 530 505 360 195 200 210 80
Albania Blue and red shrimg
Albania Blue whiting(=Po... - - - - - - - -
Albania Bluefish - - - - - - - -
Albania Bogue 132 154 80 88 55 50 78 90
Albania Caramote prawn 23 20 228 9 19 24 33 22
Albania Catsharks, nurseh...
Albania Common carp 37 214 335F 450 398 418 434 480
Albania Common cuttlefish 62 126 98 90 80 85 75 82
Albania Common dace 8 4 4 4 5 5 5
Albania Common dentex 32 43 25 22 14 13 1" 15
Albania Common octopus 82 109 47 113 165 170 173 124
Albania Common sole 63 69 120 68 79 62 44 7
Albania Common spiny lo... 3 1 2
Albania Common squids ... 107 60 64 52 76 92 105 134
Albania Croakers, drums ne 2 8 1 2 4 3 5 4
Alhania Crucian ram A 200 n 25 F PED) an aa 420 1AL M

> >

Row Details‘ = 8
1950| ] 1951| ] 1952| ] 1953| I 1954| I 1955| I 1956| | 1957| | "
1958| | 1959 | 1960] | 1961] | 1962 | 1963 | 1964 | 1965] ] v

e of 1077 [
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4.2.Notes (if applicable)

Country notes are now made visible in the data display through a red triangle. In the
past notes have been published in the annual statistical yearbook (PDF version).

¥ The red triangle only shows, if the object has note text defined.

Country (Name) Continent (Name) ASFIS species (Name) FAO major fishing arez Environment (Nam

4 Afghanistan Asia Cyprinids nei Asia - Inland waters  Freshwater

| Afghanistan ||
Albania Europe Bighead carp Europe - Inland waters Freshwater
Albania Europe Common carp Europe - Inland waters Freshwater
Albania Europe Crucian carp Europe - Inland waters Freshwater

¥ Algeria Africa Barbel Africa - Inland waters Freshwater

¥ Algeria Africa Bleak Africa - Inland waters Freshwater

¥ Algeria Africa Caramote prawn Mediterranean and... | Brackishwater

¥ Algeria Africa Common sole Mediterranean and... Brackishwater

The notes are visible by selecting a row, and then right-clicking on the Country:

o o
China

The 2000-2002 aquaculture production data for “Oriental river prawn” (Macrobrachium nipponense) have been
included based on published reports. The figures for 2003-2008 have been provided by the national reporting
office.

For statistical purposes, the data for China do not include Hong Kong Special Administrative Region (Hong Kong
SAR), Macao Special Administrative Region (Macao SAR) and Taiwan Province of China.

Data for “Turbot” for 2003-2017 were subtracted from “Lefteye flounders nei” as FAO estimates.

Attribute Value Description

» Name Country name
1ISO3 code CHN ISO3 code
1ISO2 code CN ISO2 code
Internal identifier 41 Internal identifier

p Official name Official name
Code UN (M49) 156 Code UN (M49)
FAO 12 characte... China FAO 12 characters code

The note text can be exported using copy/paste.
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4.3.Toolbar icons
The toolbar icons on the left side provide quick access to the data tools. These are
also exposed in the Data menu, where you also find a detailed explanation.

The toolbar icons on the right side provide quick access to the dataset attachments.
These are also exposed in the Metadata menu, where you also find a detailed
explanation.

4.4.Row Details

Selecting/highlighting a row (as shown above) will present the yearly data values on
the lower part of the window (as shown under the Row Details tab).

(& Row Details

4.5.Number of rows

The number of rows on display is shown in the lower-right part of the window. This
number depends on the filtering critera choosen by the user; Filtering is explained in
section 6.1 (Filter).

4789 filtered records

4.6.Memory Status

The memory bar shows the state of the Java heap memory, which is a feature of
RCP applications. This feature is useful for troubleshooting only.

551Mof733M [
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5.Edit Menu
5.1.Select all

#4 Fishstat) - FAO Global Fishery and Aquaculture Production Statistics
File Edit Data Format View Metadata Help

'@ N Select all criva | Bl in &

6 e Ctrl+N  984-2016) 52 |

All rows are selected i ¢

Cou Ctrl+C Aquaculture area (... Environment (Envi...
Afgt Preferences Ctrl+P Asia - Inland waters ~ Freshwater
Afgharusian naINUUW LIouL Asia - Inland waters ~ Freshwater
Albania Bighead carp Europe - Inland w...  Freshwater
Albania Common carp Europe - Inland w...  Freshwater
Albania Crucian carp Europe - Inland w...  Freshwater
Albania European seabass Mediterranean an...  Marine

Clicking on this option will select all the rows in the currently open dataset:

#4 Fishstat) - FAO Global Fishery and Aquaculture Production Statistics
File Edit Data View Metadata Help

1 IR BN A

{1, Global aquaculture production - Value (1984 - 2016) &2

Format

Country (Country)  Species (ASFIS spe... Aquaculture area (... Environment (Envi... # 1984 1985
i Afghanistan Cyprinids nei Asia - Inland waters  Freshwater 225 225
Afghanistan Rainbow trout Asia - Inland waters  Freshwater 60 60
Albania Bighead carp Europe - Inland w...  Freshwater 0
Albania Common carp Europe - Inland w...  Freshwater 25 50
Albania Crucian carp Europe - Inland w...  Freshwater 25 25
Albania European seabass Mediterranean an...  Marine
Albania Freshwater fishes ...  Europe - Inland w...  Freshwater 2.5 15
Albania Gilthead seabream  Mediterranean an...  Marine 0
Albania Grass carp(=White... Europe - Inland w...  Freshwater
Albania Kuruma prawn Mediterranean an...  Marine 0 0
Albania Mediterranean m...  Mediterranean an...  Marine 588.9 586.3
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5.2.Select none

#4 Fishstat) - FAO Global Fishery and Aquaculture Production Statistics

File Edit Data Format View Metadata Help
@ selectal cren | B i %
14 G 'k Select none Ctrl+N 984 -2016) &3
Cou I No rows are selected i Ctrl+C Aquaculture area (.. Environment (Envi...
| Afgl D tEEETECEs Ctrl+P  _ Asia - Inland waters  Freshwater
Afgharistan RAINDUW LIUUL Asia - Inland waters ~ Freshwater
Albania Bighead carp Europe - Inland w...  Freshwater
Albania Commeon carp Europe - Inland w...  Freshwater
Albania Crucian carp Europe - Inland w...  Freshwater

Clicking on this option will deselect any selected row in the currently open dataset:

#4 Fishstat) - FAO Global Fishery and Aquaculture Production Statistics
File Edit Data Format View Metadata Help

1 IR WL A=
{1, Global aquaculture production - Value (1984 - 2016) &2 v

~

Country (Country) Species (ASFIS spe... Aquaculture area (... Environment (Envi...
i Afghanistan Cyprinids nei Asia - Inland waters  Freshwater

Afghanistan Rainbow trout Asia - Inland waters ~ Freshwater

Albania Bighead carp Europe - Inland w...  Freshwater

Albania Common carp Europe - Inland w...  Freshwater

Albania Crucian carp Europe - Inland w...  Freshwater

Albania European seabass Mediterranean an...  Marine

Albania Freshwater fishes...  Europe - Inland w...  Freshwater

1984
225

25
25

2.5

1985

225

(=]

15
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5.3.Copy selection

¥4 Fishstat) - FAO Global Fishery and Aquaculture Production Statistics

File Edit Data Format View Metadata Help

@ selectall creA || B o %

.G Select none Ctrl+N 984 -2016) 2
Cou Copy selection Ctrl+C Aquaculture area (... Environment (Envi...
Afgh l Copy the current selection to the clipboard Pland waters  Freshwater
Afgharnstan NAINDUW LICUL Asia - Tnland waters  Freshwater
Albania Bighead carp Europe - Inland w...  Freshwater
Albania Common carp Europe - Inland w...  Freshwater
Albania Crucian carp Europe - Inland w...  Freshwater
Albania European seabass Mediterranean an...  Marine
Albania Freshwater fishes...  Europe - Inland w...  Freshwater
Albania Gilthead seabream  Mediterranean an...  Marine
Albania Grass carp(=White... Europe - Inland w...  Freshwater

i Albania Kuruma prawn Mediterranean an... Marine
Albania Mediterranean m...  Mediterranean an...  Marine

1984
225

60
25
25

0
588.9

1985

225
60

50
25

0
586.3

Selecting this option will copy all selected rows into the clipboard. When the copy of

the selected records into the clipboard is complete, a confirmation message will

appear:

l L=

'6' 9 rows have been copied to the clipboard

This option is useful if you intend to copy the selected rows directly into an opened

spreadsheet.

The settings related to how data is copied to the clipboard are managed in Edit —
Preferences — Data Export. See section 5.4 (data export) for more information.
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5.4 .Preferences

FishStatJ’s Preferences include a range of settings that can be modified by the user.
They can be accessed (i) from the Edit menu...

#4 Fishstat) - FAO Global Fishery and Aquaculture Production Statistics
File Edit Data Format View Metadata Help
'@ Select all cri+a || B o
1L G Select none Ctrl+N 984 - 2016) &3
Cou Copy selection Ctrl+C Aquaculture area (... Environment (Envi...
Afgt Preferences Ctrl+P Asia - Inland waters ~ Freshwater
Afghjhnan NAINUUW LIoUL Asia - Inland waters ~ Freshwater
Albar{ Manage FishStat) preferences i Europe - Inland w...  Freshwater
Albania Common carp Europe - Inland w...  Freshwater
Albania Crucian carp Europe - Inland w...  Freshwater

... and (ii) from the toolbar by clicking on the Preferences icon.

#4 Fishstat) - FAO Global Fishery and Aquaculture Production Statistics
File Edit Data Format View Metadata Help

@ 2R AlEME = =_-|

{1, Global aquaculture production - Value (1984 - 201 6{ -

Manage FishStat) preferences i,

Country (Country) Species (ASFIS spe... Aquaculture area (... Environment (Envi...

Afghanistan Cyprinids nei Asia - Inland waters  Freshwater

Afghanistan Rainbow trout Asia - Inland waters  Freshwater

The Preferences window is presented below. Preferences are grouped in five
categories, which are listed on the left side of the window. Specific options for each
Preferences category are listed on the right side of the window.
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5.4.1.General preferences

#4 Preferences O X

| General preferences ~ T

General preferences :
P Fishstat) general preferences

Data display

Data export Save/Load timeseries settings on exit/open
Internet access Synchronize timeseries within the same dataset
Languages

Log diagnostic reporting

Workspace download location

C\Users\Maudoux\Downloads

Restore Defaults Apply

|App|y and Closel Cancel

The General preferences options are the following:

Save/Load timeseries settings on exit/open controls if the time series
settings (like filtering, aggregation, column settings) are automatically saved
(when exiting FishStatJ) and loaded (when launching the application).

Synchronize timeseries within the same dataset: This is useful for
Aquaculture data, to keep the time series of Quantity and Value in sync. Any
filtering/aggregation settings will be applied to both time series.

If Log diagnostic reporting is enabled, FishStatJ will read the log-file and
check for any errors every time the application starts. In case the logs contain
any program errors, it copies the last two months of logs into a file called
mail.txt and ask the user to send this file to us for analysis. If the Outlook
software on Windows is installed, FishStatJ automatically prepares the e-mail
message. This option is disabled by default.

Note: FishStatJ does not automatically submit any log information. You can
check the content of the text file before sending, and you have to (manually)
send the file to FAO (refer to section 12.4.2).

In case of problems, the log analysis is useful to understand the cause of the
problem. This helps us to fix the problem for the user reporting the problem—
and to improve the quality for all users.

Workspace download location allows to set the location where FishStatJ
downloads workspaces before they are installed. We added this setting
because some users reported that the Downloads folder does not exist on
their PC.

Refer to section 12.4 for details on the log location, and FishStatJ
workspaces.
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5.4.2.Data display

The Data display preferences allows the user to specify:
* If the dataset panel automatically centers on the last column of the data each
time it a dataset is loaded (set by default).
*  Whether the width of the columns that contain values is automatically
adjusted, or a fixed width (as determined by the user).
* If the dimension column header shows the attribute name (the default), or a
generic dimension name

#4 Preferences O X

type filter text ‘ Data display preferences =T v 8

General preferences
Display the last column on time series loading

Data display
Data export Statistical measures columns width
Internet access O Dynamic width
Languages
@® Fixed width 60 <

Show dimension attribute name

Restore Defaults Apply

Apply and Close Cancel

Note: If the column width display is set too small so that the observations are not
readable, an easy solution is to set a column width of 60.



5.4.3.Data display — Number formatting

Number formatting options control how values are shown (i.e. set the number of

digits before and after decimals; use point or comma as decimal separator; use
decimal or scientific notation). It is important to note that these formatting
preferences are used for display and when exporting data.

&4 Preferences

type filter text

General preferences
v Data display
Number formatting
Symbols and Colors
Data export
Internet access
Languages

a
Number formatting P v
Statistical measure
Digits before decimals Atleast ~ |1
Digits after decimals Atmost v ||2
12345.3333 0.3333333 12345678
12345.33 0.33 12345678
Calculated measures
Digits before decimals Atleast v |1
Digits after decimals Atleast v |2
12345.3333 0.3333333 12345678
12345.33 0.33 12345678
Decimal separator Notation
(® use point (12.3) (® decimal notation ( 1000 )
(O use comma (12,3) (O scientific notation ( 1E03)
Restore Defaults Apply

Apply and Close Cancel
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5.4.4.Data display — Symbols and Colors

Symbols and Colors options control how data symbols are shown (set color and
symbol display). It is important to note that these formatting preferences are used for
display and when exporting data.

Symbols and Colors Hviov 8
General preferences
V¥ Data display . ~
Number formatting Show official value as [blank] C
Symbols and Colors . N I
Data export Show unavailable value as T color
Internet access
Languages Show negligible values (<0.5) as N ¢ color %
Show zeroes as - C| color [ =)
Show estimate as E | color %
Show mirrored as T C|  color B
Show imputed as ¢ color |
Restore Defaults Apply
Cancel Apply and Close
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5.4.5.Data export

This menu includes several options that set the modalities of data exports.

#4 Preferences O X
type filter text Export to CSV files and clipboard <~ ~ vw

General preferences
v Data display

Number formatting Export tables headers

Symbols and Colors e e e Pl - a
Split values and symbols in two columns

Data export :
Internet access ~
Languages [] Export selection criteria

Don't export symbols

Export with totals

Export citation

Re-adjust the preferences on each export

Restore Defaults Apply

IAppIy and Closel Cancel

* Export tables headers: when selected, headers are exported.

* Split values and symbols in two columns. This is to avoid issues when
analyzing the data after exporting it. Indeed, mixing symbols and figures
within the same cells in a spreadsheet can make data analysis impossible,
notably because the spreadsheet software will not recognize cells as numbers
if these contain non-numerical characters.

* Export selection criteria: will add the filtering/aggregation settings to the
export.

* Don’t export symbols. This is to avoid issues when analyzing the data after
exporting it. Indeed, mixing symbols and figures within the same cells in a
spreadsheet can make data analysis impossible, notably because the
spreadsheet software will not recognize cells as numbers if these contain non-
numerical characters.

* Export with totals on selected rows.
* Export citation. See section 9.3.

* Re-adjust the preferences on each export: selecting this will show a dialog
window before each export operation, to make sure that the proper export
settings are selected before each data export.
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5.4.6.Internet Access
The preferences regulating Internet access by FishStatJ are listed below:

* The Settings for version download are described in detail in section 12.6
(update notification).

* Use Proxy is provided in case the network is protected with a proxy server. It
allows FishStatJ to download the current information (program version and
workspaces versions) and download workspaces (data) using a proxy server.
We added proxy settings as requested by some users.

The use of proxy is controlled with the use Proxy checkbox. Proxy server IP
address and port number fields are required (must be filled) if proxy is
activated.

The Proxy user ID and Proxy Password fields can be left empty.

#4 Preferences O X

type filter text Internet access P vw

General preferences

v Data display Settings for version download

Number formatting URL |http://www.fao.org/fishery/static/FishStat)/current_version.xml
Symbols and Colors
Data export .
Proxy for version and workspace download
Internet access
Languages [Juse Proxy

Proxy IP address l 10.0.0.1

Proxy Port number I 80

Proxy user ID l

Proxy Password ‘

Restore Defaults Apply

Apply and Close Cancel
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5.4.7.Languages

The language menu allows the user to change the language in which FishStatJ is
displayed.

#4 Preferences O X
type filter text Choose the application language P v v
General preferences
v Data display @® English
Number formatting (O French
Symbols and Colors O Spanish
Data export

Internet access
Languages

Restore Defaults Apply

Apply and Close Cancel

A familiar popup window will appear if the user tries to change the language. Click on
the Yes button to restart the application.

Fishstat) will be restarted with a different language. Click "Yes" if you want to
continue
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6.Data Menu
6.1.Filter...

The timeseries filter becomes enabled once a dataset is open. Filter can be
accessed (i) from the Data menu...

#4 Fishstat) - FAO Global Fishery and Aquaculture Production Statistics
File Edit Data Format View Metadata Help

@ v Filter... F4

{1, Global a [} Aaareaate F3 B

Filter data for each of the dimensions ’

Country (C earea (.. Environment (Envi...
Afghanista Sort... F7 dwaters Freshwater
Afghanista Top/Other... F8 dwaters Freshwater
Albania and w...  Freshwater
Albania Custom groups <6 and w...  Freshwater
Albania Calculated columns... Ctrl+F6  andw...  Freshwater

... and (ii) from the toolbar by clicking on the Filter icon.

#4 Fishstat) - FAO Global Fishery and Aquaculture Production Statistics
File Edit Data Format View Metadata Help
NI TACHIEEY

e G|ol Filter data for each of the dimensions (F4) b16) =2 v




Selecting Filter will open the Time series filtering window:

% Time series filtering

Time series filtering

Country | Species | Fishing area | Unit

Include

Select the requested items for each dimension

When no selection is
made all items will be
included

% | Selection mode preferences

«

Countries by continent
Africa

Americas
Antarctica

Asia

Europe

Oceania

AAAANANA

VVVVVYVY

Exclude

Afghanistan

Albania

Algeria

American Samoa
Andorra

Angola

Anguilla

Antigua and Barbuda
Argentina

Armenia

Aruba

Australia

Austria

Azerbaijan

Bahamas

Bahrain

Bangladesh
Barbados

Belarus

Belgium

Belize

Benin

Bermuda

Bhutan

Bolivia (Plurinat.State)
Ronaire/S.Fustatins/Saha

Cancel

On the left side the items are included on the dataset panel, on the left side the items
are excluded from the dataset panel. The Include side is empty by default, meaning

that all items are shown.

Items available for filtering depend on the dimensions of the dataset loaded. In the
example above, available filters are Country, Species and Fishing area. Australia is

the only country selected in this example.

The arrow buttons copy the selected items from left-to-right or from right-to-left,
according to the direction of the buttons:

< ]
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The double-arrows copy all items in the direction indicated:

L« J Lo |

Clicking OK will activate the filter and refresh the data display in the main window.
Right-clicking on an item will display a quick selections menu:

* Select all

* Deselect all

* Invert selection

* Choose attribute allows to select the attribute used for the Filter dialog. This
setting is remembered by FishStatJ:

0 - 9 34
Exclude ) 5 AF 3
e I | 3 12 11F 10
ﬁ:ban'a selectall o 200 175F 150 2
gena Deselect all
America
Andorra Invert Selection
Angola —
j Anguilla Choose attribute » 1S02 code
" -
Antigua Details on Afghanistan FAOQ 12 characters code
P |Argentin
b | Armenia Official name
i Arub; Internal identifier
L |Austria
| |Azerbaijan ISO3 code
L Bahamas UN code
Bahrain
Bangladesh Name

* Details on [name of item] shows details on the selected item:

(=] X
Afghanistan
Attribute Value Description
1SO3 code AFG ISO3 code
Name Name
ISO2 code AF ISO2 code
Internal identifier 2 Internal identifier
FAO 12 characters Afghanistan FAOQ 12 characters code
v Official name Official name
(en The Islamic Republic of ...
(fr) la République islamique ...
(es la Republica Islamica del ...
(ar
zh
(ru
UN code 004 UN code
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6.1.1.Selection mode preferences

The Time series filtering window includes a button to open the Selection mode

preferences:

% Time series filtering

Time series filtering

Select the requested items for each dimension

Countryl Species‘ Fishing area‘ Unitl

Include

When no selection is
made all items will be
included

%% | Selection mode preferences

<
«

Countries by continent

Africa
Americas
Antarctica
Asia
Europe
Oceania

AANAANANA

VVVVVYyY

Exclude

Afghanistan
Albania

Algeria
American Samoa
Andorra

Angola

|| Anguilla
|| Antigua and Barbuda

Argentina

Armenia

Aruba

Australia

Austria

Azerbaijan

Bahamas

Bahrain

Bangladesh

Barbados

Belarus

Belgium

Belize

Benin

Bermuda

Bhutan

Bolivia (Plurinat.State)
Raonaire/S.Fustatine/Saha
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It will bring up the Selection Preferences window:

#4 Preferences O

Selection Selection

Choose selection dimension attributes

v Dimensions

Country | Species | Fishing area | Unit

Dimension: Fishing area

Concept Name Description Edit...
FAO major fishing ... Name Name

Inland/Marine areas Name Name

Ocean Name Name

Custom group Name Name

Fishing area region ~ Name Name

Oceanic area Name Name

< >

Dimension values filter

Custom group

Restore Defaults Apply

Apply and Close Cancel

A Dimension value filter can be defined for each of the Dimensions. The filter
controls the list of items shown in the Time series filtering window.

Dimension values filter (O All

(® Only those referenced
(O Custom group

All will show all items included in that particular workspace.

Only those referenced will show only reference objects which appear in the
timeseries.

Note: to apply new settings, a restart of FishStatJ is required.



6.2.Aggregate

The Aggregate function is available once a dataset is open. It can be accessed (i)
from the Data menu...

#4 Fishstat) - FAO Global Fishery and Aquaculture Production Statistics
File Edit Data Format View Metadata Help

@ v Filter... F4

{1, Global a L} Aggregate F5 3
Country (C | Ea:h Idimension can be detailed, grorL:ped or aggregated iro
Afghanista D0TL.. P dwaters  Freshy
Afghanista Top/Other... F8 dwaters Freshy
Albania and w...  Freshy|
Albania Sistom groups g and w...  Freshy|

Albania Calculated columns... Ctrl+F6 and w... Freshy

...and (ii) from the Aggregate icon in the dataset toolbar:

#4 Fishstat) - FAO Global Fishery and Aquaculture Production Statistics
File Edit Data Format View Metadata Help

IO I
{4 Global 31 Each dimension can be detailed, grouped or aggregated (F5)




€, Time series aggregation O X

Time series aggregation

Select the level of aggregation for each dimension

Country

Handpicked

Grouped
Aggregated

Continent

Species

Handpicked

Grouped

Aggregated CPC class

Production area

Detailed Handpicked

Grouped — _
Aggregated Fishing area region

Production source

Detailed Handpicked

Grouped
Aggregated

Production source

FishStatJ memorizes aggregation settings for each dataset.

On the Time series aggregation popup window, three modes of aggregation are
available for each data dimension.

* When Detailed is selected, the dimension is effectively not aggregated.

* When the user selects Grouped, the aggregation can be made on the basis
of each individual group associated with the dimension. Groups can also be
Handpicked.

Country
Detailed [ Handpicked

Aggregated Continent

Species Economic class
Detailed Economic group
Grouped Fishery commission

Aggregated  Geographical region
Custom group

* When Aggregated is selected, all the data associated to a given dimension is
aggregated.
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As an example, grouping the Country dimension by Continent while aggregating

Species and Fishing area, produces the following result:

File Edit Data Format View Metadata Help
@Y%t EKE =B

{1, Global capture production - Quantity (1950 - 2016) &2 i
Country (Continent) Species (ASFIS spe...  Fishing area (FAO ...

Africa All All
Americas All All
Asia All All
Europe All All
Oceania All All
Others All All

#4 Fishstat) - FAO Global Fishery and Aquaculture Production Statistics

Unit (Unit)
Tonnes
Tonnes
Tonnes
Tonnes
Tonnes
Tonnes
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6.3.Columns...

This function allows the user to change the columns (attributes) that are used to view

the dataset. A Preferences panel is used, because the settings are remembered.
The Columns function can be accessed (i) from the Data menu...

File Edit
8| 7
{1, Global c

Country (C
Africa

Americas
Asia
Europe
Oceania
Others

Filter...
Aggregate
[} Columns...

Cart
| Manage visible columns i
L S LU

Custom groups

Calculated columns...
All

Format View Metadata Help

F4
F5
F6
F7
F8

Ctrl+G

Ctrl+F6
All

3 (FAO ...

#4 Fishstat) - FAO Global Fishery and Aquaculture Production Statistics
Data

Unit (U
Tonnes
Tonnes
Tonnes
Tonnes

Tonneg

Tonneg

... and (ii) from the toolbar by clicking on the Columns icon.

File Edit
@ 7% A

{1, Global capture product’

Manage visible columns (F6)

Help

#4 Fishstat) - FAO Global Fishery and Aquaculture Production Statistics
Data Format View Metadata

ﬁ“’|2’€ﬂu:r.@
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4 Preferences O X

Dimensions

Periods
Choose visible dimension attributes

v Dimensions

Country | Species | Fishing area | Unit

Dimension: Country
Concept Name Description ‘ New...
Continent Name Name ‘ Edit...

‘Remove...
< >
Restore Defaults Apply

Apply and Close Cancel

For each dimension, columns can be added, modified and removed by clicking on
the New..., Edit... and Remove... buttons, respectively.

Note: For species, when the common name is not available, the scientific name will
be shown instead.

Note: When a dimension is aggregated, all attributes in that dimension are changed
for the duration of the aggregation setting to show the aggregation group.

For example if you configure to display Country(Name) and Country(ISO3-Code) and
then aggregate by Continent, both columns show Continent(Name) for as long as the
aggregation is active.
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When creating a new column or modifying an existing one, the Concept used to
display a given Dimension can be changed by selecting Concept:

= X

Dimension column settings

Concept
Attribute Continent

Economic class
Economic group
Fishery commission
Alternate attribute Geographical region

[]Use an alternate attribute

FAQ 12 characters code

For each Concept, the Attribute can be selected:

= X

Dimension column settings

Concept | Country vl
Attribute m B‘%
FAO 12 characters code
I1SO2 code
ISO3 code
Alternate attribute Internal identifier
[JUse an alternate attribute Official name
UN code

Example: for the Species dimension, the common names used to display species
can be replaced with the corresponding scientific names by selecting the Scientific
name attribute.

Periods are the years on display, which may be changed, as shown below:



#4 Preferences

Dimensions

Periods

Choose visible observation periods

v Periods

KRR ERRRERERREEREREERERE

Period
1950
1951
1952
1933
1954
1955
1936
1957
1958
1959
1960
1961
1962
1963
1964
1965
1966
1967
1968
1969

Al | None

IIChecksdecﬁon HUnchecksehcﬁo4

Restore Defaults| | Apply |

IAppIy and Closel l Cancel l
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6.4.Sort...

The Sort function can be accessed (i) from the Data menu...

31 (FAO ..

Unit (Unit)
Tonnes
Tonnes
Tonnes
Tonnes
Tonnes

#4 Fishstat) - FAO Global Fishery and Aquaculture Production Statistics
File Edit Data Format View Metadata Help

@ 7 Filter... F4
{1, Global ¢ Aggregate F5
Country (C Columns... F6
Africa [} Sort... F7
Americas l Change sort order i F8
Asia Custom groups Ctrl+G
Europe
Oceania Calculated columns... Ctrl+F6
Others All All

Tonnes

... and (ii) from the toolbar by clicking on the Sort icon.

File Edit Data Format View Metadata

#4 Fishstat) - FAO Global Fishery and Aquaculture Production Statistics
Help

1 IR %@‘Aléﬁﬁv| = | B %
i, Global captuLChangr: sort order (F7) i(1950-2016] &
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The Sort window allows to choose how to sort the data. Sorting can be different from
the columns shown on the display: for example it is possible to display the Species
dimension by ISSCAP group, but sort it by Commodity. The sort ordering (i.e.
ascending or descending) is selected using the Direction options on the right end of
the window.

= X
Sort

Choose the data sorting criteria.

Dimension/Year Concept Attribute Direction

(] Active l Country vl | Country vl | Name vl @%1: O%l
Dimension/Year Concept Attribute Direction

] Active l Species vl | ASFIS species vl | Name vl @2z O%)
Dimension/Year Concept Attribute Direction

M Active l Production area v‘ | major fishing area v‘ | Name V| OF} i
Dimension/Year Concept Attribute Direction

V] Active | Production source vl | production source v‘ | Name v| (OF:H zl
Dimension/Year Concept Attribute Direction

[ Active | Unit v| | Unit v| | Name v| OFN z)

Restore defaults Cancel

When using multiple sorting criteria, higher priority will be given to the criteria that
are positioned higher in the list order.
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6.5.Top/Other...

The Top/Other function can be accessed (i) from the Data menu...

#4 Fishstat) - FAO Global Fishery and Aquaculture Production Statistics
File Edit Data Format View Metadata Help

‘ | Y Filter... F4

{1, Global ¢ Aggregate F5
Country (C Columns... F6  ;(FAO.. Unit
Africa Sort... F7 Tonn
Americas h Top/Other... F8 Tonn
Asia Tonn
Europe l Select top records and group everything else as 'other’ -
Oceania Calculated columns... Ctrl+F6 Tonn

... and (ii) from the toolbar by clicking on the Top/Other icon.

#4 Fishstat) - FAO Global Fishery and Aquaculture Production Statistics
File Edit Data Format View Metadata Help

@ v %%“‘flﬁﬂﬁﬂzlﬁjlu;—.%

{1 Global capture pr1 Select top records and group everything else as 'other' (F8) i
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The Top/Other menu allows selecting records by the following criteria:

Top [number] of records;

Top [percentage] of records; or
records greater than [cut-off value].

Top/Other selection

Top/Other selection

by field

by measure

Select top records and groups everything else as "Other"

Dataset: Global production by production source

1

=}

g
J

o

Number

(O Records comprising
(O Values

records
percent of total

and greater

You can enter selection value (number of records/percent of records/value greater).

All records that do not meet the criteria are aggregated into others, this is why the

function is called Top/Other.

. Global production by production source - Quantity (1950 - 2016) &2

Country (Country) Species (ASFIS spe...  Production area (F... Production source... Unit (Unit)

i Indonesia

Eucheuma seawee... Pacific, Western C...  Aquaculture prod...  Tonnes

| Others

Others Others Others Others |

453

171409
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As an example, selecting the top 10 records for the year 1975 is shown below.

Top/Other selection

Top/Other selection

Dataset: Global production by production source

Select top records and groups everything else as "Other"

a X

by field | 1975 v]
by measure | Tonnes vl
(O All records

® Top | 10| records

(O Records comprising percent of total

(O Values and greater

Cancel

Note: The Top/other function automatically applies a filter for the selected measure;

because different measures cannot be compared.

For example: The capture dataset contains measure Tonnes and Numbers.

Selecting the measure (Tonnes, as shown) will filter by tonnes.
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6.6.Custom groups

The Custom groups function allows the user to define specific groups of countries,
species, fishing areas, and measures. Typically, such groups are created by users to
avoid repeated filtering for groups that are part of common workflows.

Custom groups can be accessed (i) from the Data menu...

#4 Fishstat) - FAO Global Fishery and Aquaculture Production Statistics
File Edit Data Format View Metadata Help
1 1 Filter... F4
{1, Global c Aggregate F5
Country (C Columns... F6  3(FAO.. Unit (Unit)
Afghanista Sort... F7 dwaters Tonnes
Albania Top/Other... F& =zanan.. Tonnes
Albania zanan.. Tonnes
Albania h Custom groups Ctrl6 zanan.. lonnes
Albania | Create, edit or delete custom groups used for filtering and/or aggregation

... and (ii) from the toolbar by clicking on the Custom groups icon.

#4 Fishstat) - FAO Global Fishery and Aquaculture Production Statistics

File Edit Data Format View Metadata Help
@ Y%Al E zi’f’l'

{4 Global capture production - Quantity (1950 - 20‘ Create, edit or delete custom groups used for filtering and/or aggregation (Ctrl+G)

Note: The Custom groups menu item is only available when a dataset is open.

saw Custom groups manager X

Custom groups

Create, edit or delete custom groups used for filtering and/or aggregation

Country | Species | Fishing area | Unit

Africa South of Sahara oo New...
Commonwealth of Independent States

European Union (28) #~ Delete...
USSR. Former Area of > —
Latin America and the Caribbean e
OECD - Organisation for Economic Co-operation and De- = Copy...

Group of 77

ASEAN - Association of Southeast Asian Nations
WAEMU - West African Economic and Monetary Union
Countries not in current use

< >

A number of custom groups are predefined for some time series elements. The
above screen shows the custom groups for the Country dimension, while the image
below shows custom groups that already defined for the Species dimension.

59



so» Custom groups manager

Custom groups

Create, edit or delete custom groups used for filtering and/or aggregation

Country Species| Fishing areal Unitl

Fish, crustaceans. molluscs, etc.
Aquaculture species
Capture species

a
sam New...

/’ Edit...

|
# Delete... [
|
|

2] Copy...

OK

i \ Cancel ‘

When a new custom group is to be created with the New... button, the New custom

group definition window appears on the screen.

#4 New custom group definition

s

Include

When no selection is
made all items will be ’

included

‘ Countries by continent

< Africa
Americas
Antarctica
Asia
Europe
Oceania

AAANAA

%% | Selection mode preferences

Custom group name

VVVVVYVY

Exclude

Afghanistan
Albania

Algeria
American Samoa
Andorra

Angola

Anguilla
Antarctica others
Antigua and Barbuda
Argentina
Armenia

Aruba

Australia

Austria
Azerbaijan
Bahamas
Bahrain
Bangladesh
Barbados
Belarus

Belgium
Belgium-Luxembourg
Relize

English‘ Frenchl Spanish | Arabic| Chinese| Russianl

Custom group description

English | Frenchl Spanish | Arabic| Chinese| Russianl

|

Cancel
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When an existing custom group requires editing with the Edit... button, the New

custom group definition popup is presented with the existing group members listed
in the Include field.

A Custom group name and Custom group description can be entered in the
lower part of the window. As a minimum the English field should be filled.
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6.7.Calculated columns...

The Calculated columns function allows the user to create additional columns that
are built from the original dataset columns.

Calculated columns can be accessed (i) from the Data menu...

#4 Fishstat) - FAO Global Fishery and Aquaculture Production Statistics
File Edit Data Format View Metadata Help

ﬁ ‘ Y Filter... F4

{1, Global ¢ Aggregate F5
Country (C Columns... F6 (FAO.. Un
Afghanista Sort... F7 dwaters To
Albania Top/Other... F8 =zanan.. To
Albania Custom groups Ctrl+G pan an... | To
Albania zanan.. To
Albania h Calculated columns... Ctrl+F6 =zanan.. To
Albanfa l‘v'1anagc:‘callculalted columns \turope CEandx-.. | ¥o
Alhania Evrone - Inland w Tn

... and (ii) from the toolbar by clicking on the Calculated columns icon.

#4 Fishstat) - FAO Global Fishery and Aquaculture Production Statistics
File Edit Data Format View Metadata Help

@ 7% Al E @ =B &%

{1, Global capture production

_O Ak [A0E0  ANASY 52
l Manage calculated columns (Ctrl+F6) }




When this function is accessed, a Calculated columns Preferences window
appears, where the user can create or edit calculated columns is displayed as shown
below:

¥4 Preferences O X
Calculated columns Calculated columns
Manage calculated columns properties

Calculated columns

Function Description New...
Edit...
Remove...
< >
Restore Defaults Apply

Apply and Close Cancel
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Calculated columns may be created (New...) or edited (Edit...) by clicking on the

corresponding buttons. This opens the Calculated columns definition popup

window.
= X
Calculated columns definition
Define a new calculated column Ik‘
Column name | [arithmetic mean
Function Arithmetic mean g
Computes the arithmetic mean of the set of values. Uses the definitional formula:
mean = sum(x_i) / n where n is the number of observations.
Parameters

Skipping parameters
Skip unknown values
Skip estimated values
Skip negligible values

Skip zero values

Function parameters
(O Yes @ No
(O Yes @ No
(O Yes @ No
(O Yes @ No

Gancal
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Many statistical functions are available for calculated columns, as shown below:

=

Calculated columns definition

Define a new calculated column

Column name

Function

Parameters
Skipping parameters
Skip unknown values
Skip estimated values
Skip negligible values

Skip zero values

Arithmetic mean

Arithmetic mean

Arithmetic mean

Geometric mean

Harmonic mean

Max

Median

Min

Percentile

Regression Pearson's product moment correlation coefficient
Regression coefficient of determination
Regression intercept

Regression intercept standard error estimate
Regression mean square error
Regression prediction

Regression slope

Regression slope confidence interval
Regression slope correlation significance
Regression slope standard error

Root mean square

Second central moment

Skewness

Standard deviation

Sum

Third central moment

Variance

Cancel
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When a calculated column is created, it is shown on the right side of the dataset

panel:
¥4 Fishstat) - FAO Global Fishery and Aquaculture Production Statistics - O X
File Edit Data Format View Metadata Help

1 IRZE BN PR =Y

{4, Global capture production - Quantity (1950 - 2016) &2 ] OE 2= 08
Country (Country)  Species (ASFIS spe... » 1950 1951 1952 1953 A | Arithmetic mean | #
Afghanistan Freshwater fishes ... 100 100 100 100 703.73
Albania Angelsharks, sand... 8.16
Albania Atlantic bluefin tu... - - - - 2.69
Albania Atlantic bonito 5.01
Albania Barracudas nei 0.33
Albania Bighead carp - - - - 212
Albania Bleak 87.99
Albania Blue and red shrimp 1.55
Albania Blue whiting(=Po... 0.33
Albania Bluefish 0.25
Albania Bogue 113.64
Albania Caramote prawn 20.15
Albania Catsharks, nurseh... 0.1
Albania Common carp 113.09
Albania Common cuttlefish 21.39
Albania Common dace - - - - 0.7
Alhania Cammaon dentev N £ 5.97
< > < v

Record no. 8 of 21249 filtered rows m
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7.Format Menu
7.1.Column width

#4 Fishstat) - FAO Global Fishery and Aquaculture Productio

File Edit Data Format View Metadata Help
@’ %z 5l Column width G

{1, Global capture hl\[umlr'mr farmattinn 2
Customize observation column with

Country (Country]

Selecting Column width will take the user to the Data display tab of the
Preferences window. See section 5.4.2 for more information.

7.2.Number formatting

#4 Fishstat) - FAO Global Fishery and Aquaculture Production Statistics
File Edit Data Format View Metadata Help
@ | % % 24 Column width @
{1 Global capture h Number formatting 23

Country (Country]

Customize observations number display |~

Selecting Number formatting will take the user to the Data display tab of the
Preferences window. See section 5.4.3 for more information.

7.3.Symbols and Colors

#4 Fishstat) - FAO Global Fishery and Aquaculture Production Statistics

File Edit Data Format View Metadata Help

3 - T Column width &

{1, Global capture Number formatting X

Country (Country] Symbols and Colors ea (FAO.. A
Albania S

l Customize observations and symbol colors ‘

Allhania

Selecting Symbols and Colors width will take the user to the Data display tab of
the Preferences window. See section 5.4.4 for more information.



8.View Menu

The View menu is only enabled when a dataset is open, otherwise it is dimmed (not
available).

#4 Fishstat) - FAO Global Fishery and Aquaculture Production Statistics
File Edit Data Format View Metadata Help

@ ‘ A7 % 21 A ’ = | Show details Ctrl+D

{1, Global capture productio Grand totals Ctrl+T

8.1.Show details

Selecting or deselecting this option will turn on or off the detailed information that is
displayed at the bottom of the FishStatJ main display.

The Show details option can be toggled on and off (i) from the View menu...

#4 Fishstat) - FAO Global Fishery and Aquaculture Production Statistics
File Edit Data Format View Metadata Help
'@ ’ % 2 A ‘ B [:? Show details Ctrl+D

{1}, Global capture productio Grand totals Ctrl+T
Add a tab that displays the details related to a row

Country (Country) Species

... .and (ii) from the toolbar by clicking on the Show details icon.

#4 Fishstat) - FAO Global Fishery and Aquaculture Production Statistics
File Edit Data Format View etadata Help

SRV O

{4, Global capture production - Qual Add a tab that displays the details related to a row (Ctrl+D) ‘
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Turning on this option will reduce the number of time series records on display. On
the image below, the Row Details tab is turned on.

#4 Fishstat) - FAO Global Fishery and Aquaculture Production Statistics - O X
File Edit Data Format View Metadata Help
@Y RN ABwRE= B SR
{14, Global capture production - Quantity (1950 - 2016) 52 ’ OE 2= 08
Country (Country) Species (ASFIS spe...  Fishing area (FAO ... 1950 1951 1952 1953 (n
Albania Blue and red shrimp Mediterranean an...
Albania Blue whiting(=Po...  Mediterranean an...
Albania Bluefish Mediterranean an...
Albania Bogue Mediterranean an...
Albania Caramote prawn Mediterranean an...
Albania Catsharks, nurseh...  Mediterranean an...
Albania Common carp Europe - Inland w...
Albania Common cuttlefish  Mediterranean an...
Albania Common dace Europe - Inland w... - -
Albania Common dentex Mediterranean an...
Albania Commeon octopus  Mediterranean an... v
< >
Row Details | = g
1950| | 1951| | 1952| I 1953| I 1954[ l 1955] l 1956| l .
1957I | 1958| | 1959| I 1960| I 1961| I 1962] l 1963I ]
1964| | 1965 | 1966 | 1967 | 1968 | 1969 | 1970] I
[ 21249 filtered rows ;m
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Deselecting this option will remove the 'details' shown at the bottom of the FishStatJ
main display. In the image below, the details are not displayed:

#4 Fishstat) - FAO Global Fishery and Aquaculture Production Statistics - O X
File Edit Data Format View Metadata Help

@Y QA EMG | B R

{4, Global capture production - Quantity (1950 - 2016) &2 ] OE 2= 8
Country (Country) Species (ASFIS spe...  Fishing area (FAO ... 1950 1951 1952 1953 (n
Albania Blue and red shrimp Mediterranean an...

Albania Blue whiting(=Po...  Mediterranean an...

Albania Bluefish Mediterranean an...

Albania Bogue Mediterranean an...

Albania Caramote prawn Mediterranean an...

Albania Catsharks, nurseh...  Mediterranean an...

Albania Common carp Europe - Inland w...

Albania Common cuttlefish  Mediterranean an...

Albania Common dace Europe - Inland w... - - - -

Albania Common dentex Mediterranean an...

Albania Commeon octopus  Mediterranean an...

Albania Common sole Mediterranean an...

Albania Common spiny lo...  Mediterranean an...

Albania Common squids ...  Mediterranean an...

Albania Croakers, drums nei  Mediterranean an...

Albania Crucian carp Europe - Inland w...

Alhania Nesn-water rnce Mediterransan an ~
< >

21249 filtered rows

‘ of 100sM |
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8.2.Grand totals

Activating Grand totals will create one or two (depending on the dataset) additional
tabs in the FishStatJ display that show grand totals for the time-series.

The Grand totals option can be toggled on and off (i) from the View menu...

#4 Fishstat) - FAO Global Fishery and Aquaculture Production Statistics

File Edit Data Format View Metadata Help
'@ ‘ %% %A | = £ Show details Ctrl+D
{1, Global capture productio Grand totals Ctrl+T

Country (Country) Species ({ Add a tab that displays grand total of other rows

... and (ii) from the toolbar by clicking on the Grand totals icon.

#4 Fishstat) - FAO Global Fishery and Aquaculture Production Statistics
File Edit Data Format View Metadata Help

{ IR IO EER
{1, Global capture production - Quantiq Add a tab that displays grand total of other rows (Ctrl+T)
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The new tab(s) will be opened at the bottom of the window, as shown on the image

below:
#4 Fishstat) - FAO Global Fishery and Aquaculture Production Statistics - O X
File Edit Data Format View Metadata Help
1 IRZE B NE I E R
{4, Global capture production - Quantity (1950 - 2016) £ OE 2= 8
Country (Country) Species (ASFIS spe...  Fishing area (FAO ... 1950 1951 1952 1953 A
Albania Blue and red shrimp  Mediterranean an...
Albania Blue whiting(=Po...  Mediterranean an...
Albania Bluefish Mediterranean an...
Albania Bogue Mediterranean an...
Albania Caramote prawn Mediterranean an...
Albania Catsharks, nurseh... Mediterranean an...
Albania Common carp Europe - Inland w...
Albania Common cuttlefish  Mediterranean an...
Albania Common dace Europe - Inland w...
Albania Common dentex Mediterranean an...
Albania Common octopus  Mediterranean an... v v
< > < >
2 Global capture production-NumberI 3 Global capture production - Tonnes &3 ‘ = 8
1950( 19245806.9 | 1951/ 21696672.7 | 1952| 23657310 | 1953| 24078236 | 1954( 25989307.14] 1955 27512275 |1956| 29178593 |
1957[ 20377727 |1958] 30047392 |1959| 32396833 |1960| 34700181 | 1961 33630192 |1962[ 42035679 |1963[42996371.1 |
1964( 47586827.1 | 1965/ 48653613.4 | 1966 52568635.8 | 1967| 56020668 | 1968( 59336231 | 1969 57903206 | 1970 63886816 |
| Recordno. 150f | 21249 filtered rows 28 of 1005M |

For example, the Global production by production source - Quantity dataset
(shows above) has two Grand total tabs (Number and Tonnes) because two types
of units can be used to display the data.

Note: When selecting a grouped aggregation (refer to section 6.2) which has
overlapping group members the total shown is not the sum of the data on display,
but the sum of the underlying raw data. Overlapping means, that a dimension (for
example country) of a statistical observation is present in more than one group. In
this case, the observations (for example catch) of this country are counted for each
of the groups of which the country is a member; but are only counted once for the
total.

Examples of overlapping groups are economic groups or RFB (ac country can be
member of several regional fishery bodies).

72



9.Metadata Menu

The Show notes..., Show citation... and Show map... items are enabled
depending on the attachments that are available for the current dataset.

9.1.Show metadata...

Selecting this option will display the metadata about the time-series that is selected
within FishStatJ.

Metadata can be accessed (i) from the Metadata menu...

#4 Fishstat) - FAO Global Fishery and Aquaculture Production Statistics

File Edit Data Format View Metadata Help

ﬁ’ % 8 “A| g £ ﬁ\)| | b Show metadata...

{,, Global capture production - Qua - -
""" P P Show dataset and time series metadata
Country (Country) Species (ASF Citation...

Albania Blue and red Show map...

... and (ii) from the toolbar by clicking on the Metadata icon.

#4 Fishstat) - FAO Global Fishery and Aquaculture Production Statistics
File Edit Data Format View Metadata Help
I AT IR GEE
{4, Global capture production - Quantity (195q Show dataset and time series metadata




An example of the window showing metadata is shown below:

4% Metadata

Metadata

Global capture production - Quantity (1950 - 2016)

Metadata |§Dimension§f| Attachmentsl time series

Global capture production

Acronym COUNTRY

Acronym COUNTRY

Countryl Speciesl Fishing areal Unitl
Dimension Country
Description Country or territory
Concept Country
Description Country or territory

UN_CODE 1SO_3_CODE
0 EUR
004 AFG
008 ALB
010 ATA
012 DZA
016 ASM
020 AND
024 AGO
028 ATG
031 AZE
032 ARG
<

NAME.EN
European Union
Afghanistan
Albania
Antarctica oth...
Algeria

American Sam...

Andorra

Angola

Antigua and B...
Azerbaijan
Argentina

NAME.FR

Union Europé...

Afghanistan
Albanie

Antarctique a...

Algérie

Samoa ameéric...

Andorre
Angola

Antigua-et-Ba...

Azerbaidjan
Argentine

NAME.ES
Unién Europea
Afganistan
Albania
Antartida otros
Argelia

Samoa Americ...

Andorra
Angola
Antigua y Bar...
Azerbaiyan
Argentina

ISO_2_CODE
EU
AF
AL
AQ
DZ
AS
AD
AO
AG
AZ
AR

ALPHA12_ C A

EU
Afghanistar
Albania
Antarctica
Algeria
Amer Samo
Andorra
Angola
Antigua Bar
Azerbaijan
Argentina ,

>

Copy to Clipboard
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9.2.Show notes...

Selecting this option will display the notes attached to a dataset. Notes contain
descriptions about the time-series that is selected within FishStatJ.

Notes can be accessed (i) from the Metadata menu...

#4 Fishstat) - FAO Global Fishery and Aquaculture Production Statistics

File Edit Data Format View Metadata Help
@‘ %% 2 A | B ﬁ\»” | Show metadata...

{1\, Global capture production - Qua Show notes...

- Clhmsss mikadion
Country (Country) Species (ASF Show dataset notes (if any)

Albania Blue and red map...

... and (ii) from the toolbar by clicking on the Notes icon.

SEE =1

Note: The Show notes menu item is enabled and the Notes icon is shown when
the current dataset has notes embedded.
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An example of the Notes window is displayed below:

= X
Global production - General notes %

Global production - General notes 2

GLOBAL FISHERY PRODUCTION ~

The annual series of total fishery production begin in 1950. Data relate to nominal catch of fish, crustaceans and molluscs, the
production of other aquatic animals, residues and plants and catches of aquatic mammals, taken for commercial, industrial,

recreational and subsistence purposes from inland, brackish and marine waters. The harvest from mariculture, aquaculture and
other kinds of fish farming is also included.

Data include all quantities caught and landed for both food and feed purposes but exclude discards. Catches of fish, crustaceans
and molluscs are expressed in live weight, that is the nominal weight of the aquatic organisms at the time of capture. The harvest
of aquatic plants is given in wet weight. Data are given in tonnes (=1000 kg). except those for whales, seals and crocodiles,
which are given in numbers.

To assign nationality to catches, the flag of the fishing vessel 1s used, unless the wording of chartering and joint operation
contracts indicates otherwise.

Fish, crustaceans, molluscs and all other aquatic organisms included in the database have been classified according to
approximately 2309 commercial species items, further arranged within the 50 groups of species constituting the nine divisions of
the FAO International Standard Statistical Classification of Aquatic Animals and Plants (ISSCAAP). Starting with the March
2002 release, data included in this dataset reflect a revision of the ISSCAAP groups. This revision affected names and species
attribution of groups 33, 34 and 37 of the Marine Fishes division. The taxonomic code descriptors are taken from the "ASFIS list
of species for fishery statistics purposes”.

According to the inland or marine area where caught, capture production is also classified into eight major inland fishing areas
and 19 major marine fishing areas, internationally established for fishery statistical purposes. v
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9.3.Show citation...

Selecting this option will display the dataset citation, allowing to copy/paste it for
easy reference.

The dataset citation can be accessed (i) from the Metadata menu...

#4 Fishstat) - FAO Global Fishery and Aquaculture Production Statistics

File Edit Data Format View Metadata Help

'@ | %% 2 A ‘ B fo ‘ | Show metadata...
{1}, Global capture production - Qua Show notes...
Country (Country) Species (ASF Show citation...
Albania Blue and red Shoucman

y ‘ Show dataset citation (if any) }

Al - ni (R

... and (ii) from the toolbar by clicking on the Citation icon.

|:'1 1. Global production by production source - Quantity (1950 - 2016) &2 @ 2 & < 0

Note: The Show citation menu item is enabled and the Citation icon is shown
when the current dataset has a citation embedded.
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An example of the Citation window is displayed below:

=
Global production by production source - Citation

This database contains the volume of aquatic species caught by country or area, by species items, by
FAQ major fishing areas, and year, for all commercial, industrial, recreational and subsistence purposes.
The harvest from mariculture, aquaculture and other kinds of fish farming is also included.

When quoting Fishstat) data, please use the following reference:

FAQ Fisheries and Aquaculture Department [online]. Rome. Updated 2018,
www.fao.org/fishery/statistics/software/fishstatj/en|

FAQ. 2018, Fishery and Aquaculture Statistics. Global preduction by production source 1950-2016 (Fishstat)). In:
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9.4.Show map...

Selecting this option will display the map attached to a dataset. Those maps usually
represent FAQ'’s fishing areas.

The Map can be accessed (i) from the Metadata menu...

#4 Fishstat) - FAO Global Fishery and Aquaculture Production Statistics

File Edit Data Format View Metadata Help
@‘ %% 2 A | E | ﬁ\)’ | Show metadata...

{1\, Global capture production - Qua Show notes...

Country (Country) Species (ASF Show citation...

Albania Blue and red Show map...

Albania Blue whiting(

Allhania Dliiofich

-

:‘ Show dataset map (if an;ﬂ

... .and (ii) from the toolbar by clicking on the Map icon.

|J,,,A Global production by production source - Quantity (1950 - 2016) &2 Q : = b I

Note: The Show map menu item is enabled and the Map icon is shown when the
current dataset has a map embedded.
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An example of the Map window is displayed below:

(=] X
Global production - Map of fishing areas
Global production - Map of fishing areas

Qw‘@ redandagiaie - FAO Major Fishing Areas for Statistical Purposes

United Nations

©FAO 2015

‘The designations employed and the presentation

of information in the map(s) are for ilustration only and

do not imply the expression of any opinion whalsoever on the part
of FAQ concerning the legal or consitutional status of any countr

. g
ooy or 508 e o conerin 8 G f onias o puncars. e
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10.Help Menu

The Help menu is shown below. It gives access to additional tools, preferences and
help related to the FishStatJ software.

#4 Fishstat) - FAO Global Fishery and Aquaculture Production Statistics
File Edit Data Format View Metadata Help
@’V/’ %;’f:‘. AA‘EEﬁ\')‘ E|i Getting Started
{1, Global capture production - Quantity (1950 - User Manual

Country (Country)  Species (ASFISspe.. Fi my  Apout FishStat) 19

10.1.Getting Started

#4 Fishstat) - FAO Global Fishery and Aquaculture Production Statistics

File Edit Data Format View Metadata Help
@Y R A BB = E Getting Started

{1, Global capture production - Quantity (1950 - ['} llcer Mannal
Open the Getting Started manual f

Country (Country) Species (ASFIS spe... Fi e " About Fishstat) T950

The Getting Started item from the Help menu automatically downloads the Getting
Started with FishStatd manual and opens it. The manual is a portable document
format (PDF) file.

*  Windows requires Acrobat Reader to open PDF documents
* macOS can open PDF documents using the Preview application

Note: When working with unreliable internet access, we suggest to open the manual
when an internet connection is available, as this will make it available in case of
future connection interruptions.

10.2.User Manual

#4 Fishstat) - FAO Global Fishery and Aquaculture Production Statistics

File Edit Data Format View Metadata Help
@ 7 %4 Al v = | E Getting Started
{1, Global capture production - Quantity (1950 - h User Manual

Country (Country) Species (ASFIS spe...  Fi F{ Open the FishStat) user manual i

o

The User Manual item from the Help menu automatically downloads the FishStatJ
manual and opens it. The manual is a portable document format (PDF) file.

* Windows requires Acrobat Reader to open PDF documents
* macOS can open PDF documents using the Preview application
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Note: When working with unreliable internet access, we suggest to open the manual
when an internet connection is available, as this will make it available in case of
future connection interruptions.

10.3.About FishStatJ

#4 Fishstat) - FAO Global Fishery and Aquaculture Production Statistics
File Edit Data Format View Metadata Help

e|v/’ %?v AA|EEﬁ\')| ZIE Getting Started

{1, Global capture production - Quantity (1950 - User Manual
Country (Country) Species (ASFIS spe... Fi w4 n About FishStat)
Albania Blue and red shrimp Medltj%m&mec—\
Allhania Blie whitinal=Da Madisd 2nOW FishStat Info

This item presents FishStatJ information about the program version, legal use, and
contacts for assistance. The About FishStatJ window is shown below:

#4 About FishStat)

FOO0 BND AICUL TURE ORGANGIATION (F THE
U e sanoses.

Fisheries and
Aquaculture Department

Installation Details

O X

FishStat), a tool for fishery statistics analysis
Release: 3.05.0-b15
by Thomas Berger, Fabrizio Sibeni and Francesco Calderini

This product includes software developed and distributed under the EPL,
LGPL and Apache licenses.

Please also refer to the Dataset Notes (Menu | Metadata | Show Notes)
Questions and feedback should be addressed to:

FAQ

Fishery and Aquaculture Department

Statistics and Information Branch

Email: Fish-Statistics-Inquiries@fao.org

Visit http://www.fao.org/fishery/statistics/software/fishstatj/en

Close
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11.Frequently asked questions (FAQ)

11.1.How to export data?
You can export data from FishStatJ in two different ways (for more information, refer
to section 5.4):

* You can simply copy a selection of rows and paste it on an Excel file (with the
right button menu or with the CTRL + C shortcut).
* Oryou can go to File — Export selection (CSV file)...

You can configure how data and symbols are exported (or not exported) in Edit —
Preferences — Data export (refer to section 5.4.5)

11.2.What does that symbol mean?

FishStatJ uses the following symbols for statistical data:

Data not available; unobtainable; Data not separately available but
included in another category

- Nil or zero
0 More than zero but less than half the unit used
F FAO estimate from available sources of information

nei Not elsewhere included

In FishStatJ, you can configure the color of the symbols in the panel:
Edit — Preferences — Data Display — Symbols and Colors (refer to section
4.4.4).

As for data and symbol export to Excel, please be informed that you can configure
how data and symbols are exported (or not exported) in:

Edit — Preferences — Data export.

Don’t export symbols is one of the options you can select (refer to section 5.4.5).

11.3.Why am | getting different numbers than those
from the FAO Yearbook of Fishery and Aquaculture
Statistics/SOFIA?

Trying to cover all products derived from fisheries activities, in both inland and
marine waters, the FAO Fishery production datasets (capture and aquaculture),
include some products which are not (or not directly) destined to food consumption,
such as marine mammals, crocodiles, corals, pearls, mother-of-pearl, sponges and
aquatic plants. Those products are excluded from the all country, regional and world

83



totals presented in FAO Yearbooks of Fishery Statistics as well as other FAO
publications.

When viewing time-series data in FishStatJ, in order to obtain the same aggregates
you must first filter the dataset using a Custom Group:

1. Open the Time series filtering window (Data — Filter or F4)

2. Click the ASFIS Species tab

3. Click the Species selection groups of Yearbook/SOFIA group

4. Click Fish, crustaceans, molluscs...

5. Click the single left arrow in order to move all selected species belonging to Fish,
crustaceans, molluscs, etc. under the Include panel on the left.

6. Click on the OK button. The program will return you to FishStatJ’s main window.

The aggregation grouping for capture and aquaculture datasets is mentioned in the
dataset notes where applicable. Access to dataset notes is explained in section 9.2.

11.4. FishStatJ working offline?

When the download of the auto-update information fails, FishStatJ produces the
following warning:

#4 FishStat) is working off-line X

> \  http://www.fao.org/fishery/static/FishStat)/current_version.xml
@7 3 checkforapplication updates and download of data is not possible.

Only workspaces installed previously are available.

To fix this, please connect to the internet or update firewall settings.

If there is no internet connection possible, FishStatJ will run but the following
functions will not be available:

* The notification of a new program version is not available (Refer to section
12.6 for a detailed description of the auto-update notification, and a
description of data download from the internet).

* No workspaces are shown for automatic download: the Manage workspaces
dialog only shows workspaces already downloaded/installed (refer to section
3.1)

* Download of the user manual is not possible (refer to section 10.2)
Section 5.4.6 explains Internet access proxy configuration.
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11.5.Some historical data figures have changed.
Why?

Refer to section 12.3 for a discussion on data revisions.

11.6.Where to find detailed notes for each dataset?

Additional information about the statistics presented in each dataset collection are
available in the General notes, accessible in Metadata — Show metadata —
Attachments (or by clicking on top right button of data panel).

Refer to section 9.2 and 9.3 for viewing dataset notes and data citation.

11.7.How often is the data/application updated?

We publish new data as soon as we receive the complete set from member
countries and have completed our verification. Usually, datasets are updated once
per year. The release time for Global Capture and Aquaculture Production is in the
second quarter every year.

New or updated datasets will automatically show in the Manage workspaces menu;
refer to section 3.1 for a detailed explanation.

When the FishStatJ application is launched, it will also check for updates — and
inform you if there is a new version available for download; refer to section 11.6 for
the auto-update notification.

Data update/revisions are explained in section 12.3; internet access is discussed in
section 5.4.6.
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11.8.FishStatJ is being flagged as a virus threat

We have received various reports indicating that the FishStatJ software has been
falsely identified as being a virus threat. Indeed, we work hard for FishStatJ to be the
best product possible, and we would not knowingly distribute an infected version.

Wikipedia defines a false-positive as a false alarm: wikipedia.org/wiki/
False_ positives_and_false_negatives.

If you receive such alert from your antivirus software, we suggest the following
actions, in the following order:

* Please send us an e-mail (Fish-Statistics-Inquiries@fao.org), describing the
antivirus software used, and the alert message received (this way we can
double-check your download, and also warn other users).

* Please inform you virus software vendor and notify them of the ‘false positive’
indication. The vendor can then quickly investigate (check our download) and
release an update to their virus definitions (definitions are patterns to detect
infected software).

* If you think FishStatJ is corrupted, the best is to re-download and expand a
fresh copy.

NEVER consider deactivating your virus protection - that would be irresponsible in
this digital age!

11.9.How does FAO assign nationality to catches?

As established by the United Nations Statistical Commission in 1954, catches are
assigned to the country of the flag flown by the fishing vessel. The flag State is also
responsible for the provision of the relevant data to FAO and other organizations
such as Regional Fishery Bodies (RFBs).
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11.10.FishStatJ has a Log4j vulnerability?

FishStatJ is an Eclipse RCP (Rich Client Platform) application, and log4j is included in
FishStatJ as part of the Eclipse platform.

Vulnerability Status:

The vulnerability applies only to log4j2 but Eclipse/FishStatJ uses log4j(-1) v2.12.
The safest mitigation for the vulnerability is to remove or disable JNDI, but Log4j
does not have any JNDI functionality.

Log4j lacks JNDI, no mitigation effort is possible, and therefore log4j is not an
attack vector.

Keep in mind, FishStatJ is very different from a web-server, where the hacker can
input/control what is written to the log. FishStatJ is a data query tool, and there is
absolutely no data entry, no text entry, by the user. Furthermore, FishStatJ is a user
application — runs in user space; and does not use or require elevated privileges. As
such, the log4j update is a low priority for the Eclipse IDE project. Recall, the Eclipse
IDE is an open-source project, which has no regular funding/support.

Summary:
The log4j2 vulnerabilities, in particular, CVE-2021-44228 and CVE-2021-44832,

do not apply to FishStatJ.

We are constantly updating FishStatJ, and the log4j plugin will be updated to log4;j2
as soon as this update for the Eclipse IDE is available.
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12.More on FishStatJ

12.1.FishStatJ legal specifications

The FishStatJ software is provided free of charge to member countries of the Food
and Agriculture Organization of the United Nations (FAO). It may be installed on
personal or company computers without restriction or license. The statistics
contained in this package may be used and published freely provided that the source
is cited as FAO.

12.2.Bibliographic citation

FAO encourages the use, reproduction and dissemination of material in this
information product. Except where otherwise indicated, material may be copied,
downloaded and printed for private study, research and teaching purposes, or for
use in non-commercial products or services, provided that appropriate
acknowledgement of FAO as the source and copyright holder is given and that
FAO’s endorsement of users’ views, products or services is not implied in any way.

All requests for translation and adaptation rights, and for resale and other
commercial use rights should be made via fao.org/contact-us/licence-request or
addressed to copyright@fao.org.

When quoting FishStatJ data, please use the reference that you can find in the
General Notes attached to each dataset (Metadata — Show metadata —
Attachments).

The citation for each dataset is available in the Metadata — Show citation menu.

The bibliographic citation for FishStatJ is as following:

FAO Fisheries Division, Statistics and Information Branch. FishStatJ:
Universal software for fishery statistical time series. Copyright 2020.

12.3.Data versioning and Data revisions

Where necessary, the data published in the previous releases of the dataset(s) of
fishery and aquaculture statistics are revised.

Where figures in this release differ from those previously published, the amended
data represent the most recent version. Some statistics provided to FAO by national
offices, in particular those for most recent year, are provisional and may be amended
in future editions.4.

An example of the version of FishStatJ is “2020.1.0”

Major version: is the year when the data was released (2017)
Minor version: is the release (1) and revision number (0)
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Occasionally, we find errors, or we receive data from member countries after the
release of the FishStatJ workspace. In these rare cases, we release a new revision
of the data by increasing the revision number. This way, the new version is
automatically visible in the Workspaces Manager as a new download. In this case,
we would also include an explanation in the dataset notes. Refer to section 9.2 how
to view dataset notes.

12.4.FishStatJ workspace folder

FishStatJ stores imported workspaces (and application files) in the user home
directory:

* For Windows, use the Windows + R shortcut to open the Run command,
enter %USERPROFILE%\fishstatj_workspace and click OK

* For macOS Finder enter ~/fishstatj_workspace in Go — Go to Folder menu
The information inside workspace folder is described in detail below.

Refer to section 11.5 how to remove (un-install) FishStatJ.

12.4.1.FishStatJ workspaces

Workspaces are stored in the FishStatJ workspace folder. They contain the time-
series data, including the reference data (dimensions), and attachments (maps,
dataset notes). There is one folder for each workspace installed.

Workspaces can be deleted permanently from disk, by opening the Manage
workspaces menu and by using the Delete button.

12.4.2.Workspace metadata folder

The FishStatJ application’s log and preferences are stored in the workspace folder,
in a sub-folder called “.metadata”.

The FishStatJ application log is called “.log”.

FishStatJ application preferences are saved in this location:
.metadata/.plugins/org.eclipse.core.runtime/.settings

Note: on macOS files and folders starting with a dot an invisible. To open the folder
enter ~/fishstatj_workspace/.metadata in Go — Go to Folder menu.

To show files and folders starting with a dot, press the “Command” + “Shift” + “.”
(period) keys at the same time.

12.4.3.Workspace manual folder

The FishStatd manual is downloaded and opened from the manual folder inside the
fishstat workspace. Refer to section 9.2 for more details on the manual.
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12.5.Un-installing FishStatJ
FishStatJ can be un-installed by deleting the FishStatJ application folder (macOS:
the application icon). The Windows application is usually located at: C:\FishStatJ.

FishStatJ stores imported workspaces (data) in the user home directory; these can
be deleted as well:

* For Windows enter %USERPROFILE%\fishstatj_workspace in the Run
menu

* For macOS Finder enter ~/fishstatj_workspace in Go — Go to Folder menu

FishStatJ is a cross-platform application and therefore does not use the Windows-
registry, it stores all data and settings in the application and user home directory, as
described above.

12.6.FishStatJ update notification

Starting with version 3.01 FishStatJ has automatic update capability built in. At

program launch a very small XML file (~1KB) is downloaded from the FAO web-site.

If the download of this file fails, FishStatJ will show a warning message (refer to
section 10.6— No internet connection) and will continue to work with the data
downloaded locally.

The URL download location of the XML file is shown in preferences, refer to section
4.4.6 - Internet Access.

The XML file enables the following 3 functions in FishStatJ, which are described
below.

12.6.1.Automatic update notification

When we release a new version of FishStatd, Windows users will see the following
message at program startup; macOS users receive the program update notification
shown in 11.6.2:

#4 New version FishStat) ped

"0' There is 2 new FishStat) v3.05.1 available. Download and Install ?

Start update Manual download Cancel

Clicking the Start update button will start the download of the auto-extract file:
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#4 Progress Information

'0' downloading FishStat)_3.05.1_Installer.exe

Cancel

Once the download is complete, FishStatJ quits, and the extraction dialog appears:

-

FishStat) auto-extract (e

.;0;. Install to C:\FishStat] ?

Yes No |

Details >>

Clicking the Yes button will expand the software, and launch the new version of

FishStatJ.

If no internet connection is available at start-up, a message appears (section 10.6—

No internet connection).

12.6.2. update notification

When we release a new version of FishStatJ, you will see the following message at

program startup:

%4 New version FishStat)

N There is a new FishStat) v3.00.2 available. Open the web-page ?

=

=)

[ No

Clicking the Yes button will open the FAO FishStatJ web-page in a web browser. On

this page, you find the latest FishStatJ application for download.

Note: The user has to perform the download of the application program, and install it
on the PC. There is no auto-download or auto-update of the application.

If no internet connection is available at start-up, a message appears (section 10.6—

No internet connection).
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12.6.3.Workspace download

FishStatJ will show new or updated workspaces in the Manage workspaces dialog.
Using this dialog, the user can choose which workspace to download and install on
the PC.

For a description of the workspace management; please refer to section 3.1-Manage
workspaces.

Refer to section 12.3 for an explanation of workspace/data versioning.

Available workspaces, their version and download location are contained in the XML
file; if no internet connection is available then only workspaces downloaded and
installed previously are shown.

12.6.4.FishStatJ manual download

The first time the user manual is opened, or when a new version is available, the
PDF manual is downloaded. The version of the manual and download location of the
manual is contained in the XML file.

Refer to section 10.2 (User Manual) for how to open the FishStatJ manual.

The FishStatJ manuals are downloaded to the workspace folder. Refer to section
12.4.3 (FishStatJ manual folder).

When running offline, the manual can only be opened if it was previously
downloaded.
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12.7.Assistance and Contact

On the FishStatJ web-page (fao.org/fishery/statistics/software/fishstatj/en) you can
find

* New program versions for download

* Alist of workspaces and their versions available for download using FishStatJ

* A quick-start guide for installing the program
* The download link to this manual
* The e-mail contact for support (fish-statistics-inquiries@fao.org)
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